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1 Welcome to SWRate Software
1.1 What is SWRate Software?

Southwire’s SWRate software is a PC-based program that calculates resistance, reactance, and thermal ratings of
overhead conductors in accordance with current standards. SWRate Lite software is available as a no-cost “lite” version
of the SWRate Pro software. Each software includes an extensive database of overhead conductors and cables. The
calculation methods used in SWRate software are based on IEEE 738-2012. Data provided in the conductor tables and
conductor calculations are based on ASTM 02.03-2020.

1.2 Who Can Use SWRate Software?

Southwire intends the SWRate program to be used by qualified engineers and designers who have a foundation of
knowledge about overhead power transmission and distribution lines, and the performance of conductors used in
those lines. When using the SWRate program, a qualified engineer should review the parameters input for the
calculations, and the resulting calculated data, and verify that they are correct for the specific application.

1.3 SWRate Highlights

1.3.1 SWRate Features

Inside an easy-to-use menu-driven interface, SWRate software will calculate, for a specific set of input conditions:

e DC/AC resistance at any operating temperature

e Thermal ratings for a determined temperature range under various combinations of solar and wind conditions
(Pro version only)

e A steady-state conductor thermal rating for a given conductor temperature

e A steady-state conductor temperature given a steady-state current

e Atransient conductor thermal rating provided a maximum transient temperature, duration, and starting
condition

e Atransient conductor temperature provided a transient current, duration, and starting condition

e Conductor GMR (Pro version only)

e Conductor reactance for various bundle/phase configurations (Pro version only)

e Batch steady-state and transient results for each conductor type, including conductor properties, resistance,
and reactance (Pro version only)

e (Calculation results in U.S. Standard or Metric units
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Data furnished includes conductor properties for the following conductor types:

o AAC e AAC/VR2

e AAC/TW e ACSR/VR2

o AAAC e Al Bare

e ACAR e Al Duplex

e AACSR o Al Triplex

e ACSR e Al Quadruplex

e ACSR/TW e HD Copper

e ACSR/AW e MHD Copper

e ACSS e SD Copper

e ACSS/TW e Cu Duplex

e ACSS/AW e Cu Triplex

e ACSS/TW/AW e Cu Quadruplex

e MaxStorm™ e AAC Line Wire

e ACCS/TW/C7®-TS e AAAC Line Wire

e ZTACCR/TW/C7®-TS e ACSR Line Wire

e ACCS/TW/C7°-TP e AAC Tree Wire/Spacer Cable
e ZTACCR/TW/C7®-TP e ACSR Tree Wire/Spacer Cable
e ACCR e C7°® Tree Wire/Spacer Cable
e ACCR/TW

1.4 Installation

1.4.1 Southwire’s SWRate Software Package Includes:

Product key

Download link

Installation Instructions link
Documentation link

User’s Manual link

Other helpful links

o vk wN e

1.4.2 SWRate Installation Instructions

1. After downloading the SWRate installer, double-click the “SWRate_install. msi” file to begin installing SWRate
software.
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SWRate_install.msi

Click Next on the Welcome to the SWRate Setup Wizard screen.

5]

@ Welcome to the SWRate Setup Wizard

The Setup Wizard wil install 5WRate on your computer, Click
Mext to continue or Cancel to exit the Setup Wizard.

Back Cancel

2. By default, the SWRate program will be installed under the “C:\Program Files (x86)\Southwire\SWRate”
folder.
3. Click Finish.
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Completed the SWRate Setup Wizard

Click the Finish button to exit the Setup Wizard.

4. To launch the SWRate program, either double-click the Desktop shortcut or search “SWRate” in the Start
menu.

1.4.3 SWRate Pro Licensing

If you have purchased SWRate Pro software, you will need to enter a valid product key to activate the full
version of the software with Advanced features. To do so, click Upgrade to Pro at the top of the SWRate
Main Menu screen after opening the program (Contact OHT@southwire.com for a product key).

1. Inthe Southwire Licensing screen, enter your Product Key in the space provided.
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License Acquisition License Information

overovuc e |

(® Network | |
(O standalone

Machine Identifier
| |

| @ Internet

[ se Proxy service Modues |

Configure Proxy Service

O Email

|web01 .idsengineering.com |

Checkout

2. License Type should be Network. By default, the License Source will be set to Internet. If you do not have a
valid internet connection, you may choose the Email option.
a) If you choose Internet and DO NOT use a proxy service, proceed to Step 3 below.
b) If you choose Internet and need to use a proxy service, check the box beside Use Proxy Service and
click Configure Proxy Service.

Next, enter your proxy server address and click Accept.
Finally, proceed to Step 3 below.
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License Acquisition License Information

overovuc e |

(® Network | |

(O standalone

| |
| @ Internet

[ Use Proxy service Modues |

Configure Proxy Service

c) If you choose Email, you will need to request a license file.
i.  Click the Request button.
ii.  You will be prompted to select a folder under which to save the license request file (Ex:
filename “LicenseRequest.YYYY-MM-DD.xml” will be generated).
iii. Click OK.
iv. A window will appear with instructions on where to email the previously generated license
request file.

To obtain your license:

1. Email the request file located at C:\Users\pearsond\Desktop
\LicenseRequest.2020-10-12.xml to licensing@idsengineering.com.
2. You should receive a license file within 2 business days. Once
you receive it, load the application and use the Process button to
apply it to your software.

OK
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v.  When you receive the license file from Southwire, reopen the program and click Upgrade to
Pro at the top of the Main Menu screen. Within the Southwire Licensing screen, again click
Email under License Source, then click the Process button to apply the license file. You will
need to navigate to the folder where the license file is located (Ex: “test_license.lic”) and
click Open. If successful, proceed to Step 4.

ssl Op

— v 4 ‘r > ThisPC » Downloads v ) Search Downloads

Organize v New folder =~ [ O

" Name Date modified Type
# Quick access

v Last week (1)

I Desktop
& Downloads B test_licenselic 0/1/2020 8:55 AM License
Dwp
OHT Dept
‘ Standards Co
Spreadsheet /
‘ » Syncplicity (T
oo .. e >
File name: l ~ | | License File (*.lic) v
Open Cancel

3. Click the Checkout button.
4. Once a license is successfully checked out, the Status section of License Information will be updated to say
Licensed and will be visibly green.
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Southwire Licensing

License Acquisition License Information

froverropucr e |

(® Network | |
(O standalone
Machine Identifier
| |
® Internet
[ T
Configure Proxy Service Overamp, 2018
DATAUPDATE, NEVER
SWUPDATE, NEVER
O Email

License Server

|web01 .idsengineering.com |

Checkout

5. Click Close.
6. You will be prompted with the SWRate End User License Agreement (EULA) and will need to click Accept or

Decline.
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License Terms
SWRate_EULA.rtf

Licensed Program End User License Agreement

IMPORTANT: THIS LICENSED PROGRAM END USER LICENSE AGREEMENT IS A LEGAL AGREEMENT BETWEEN THE LICENSEE AND
SOUTHWIRE. READ IT CAREFULLY BEFORE COMPLETING THE INSTALLATION PROCESS AND USING THE LICENSED PROGRAM. IT
PROVIDES A LICENSE TO USE THE LICENSED PROGRAM AND CONTAINS WARRANTY INFORMATION AND LIABILITY DISCLAIMERS. BY
INSTALLING AND USING THE LICENSED PROGRAM, LICENSEE IS CONFIRMING TO SOUTHWIRE ACCEPTANCE OF THE LICENSED
PROGRAM AND AGREEING TO BECOME BOUND BY THE TERMS OF THIS AGREEMENT. IF LICENSEE DOES NOT AGREE TO BE BOUND BY
THESE TERMS, THEN SELECT THE "CANCEL” BUTTON TO NEGATE THE LICENSED PROGRAM INSTALL. LICENSEE MAY THEN CONTACT
SOUTHWIRE FOR A FULL REFUND OF THE PURCHASE PRICE LICENSEE PAID FOR THE LICENSED PROGRAM.

Definitions
(a) “Southwire” means Southwire Company, LLC and its suppliers and licensors, if any.
(b) “Agreement” means, collectively, this SAG10 and/or SWRate Pro End User License Agreement and Maintenance Agreement.

(c) “Documentation” means the user's manual and/or other documentation or media made available to Licensee along with the
Licensed Program, whether in tangible or electronic form.

(d) “Licensed Program” means the Southwire licensed program purchased pursuant to this EULA and application, including
Documentation, together with the Updates specified by this Agreement to be supplied as part of Maintenance under this
Agreement.

(e) “Maintenance” means, collectively, the services to be provided by Southwire as stated in the Maintenance Agreement.

(f) “Licensee” means a Person that has been granted a license to use the Licensed Program pursuant to the terms of this
Agreement.

7. Upon acceptance of the EULA, the program will reload, and you will be able to use the SWRate Pro

p

rogram.

File Help

'I'ype:| V| Name:l VI Slze:|

I S
Conductor Information Surface Construction Local Conditions

QO Black @ Single

Material: | 1350-H19 Al 61.2% v O Non-spec Duplex Ambient: C
O New Triplex )

Wind Speed: fus
Q Gray Quadruplex i
@® Average Ins. Thickness Wind Angle: .
I o

Thermal Coeffs . - Sun: wife

Strand Count:
Strand Diameter:

Stranding Factor:

Condition Settings

Outer Diameter:

Absorpﬁvw' Heutal Domeis Solar Day: [jJun v |10+

Compression: Local Time:

Strand Lay: Spec Sheet Information *24:00 - Midnight, 12:00 - Noon
*Enter Strand Lay if single-layer ACSR Strength:
Location Conditions
RBS: Ib
Core Information [:] Frequency:
inl- Weight: Ib/Mft
Strand Count:

- Temperawre: [ ] ¢

in P N. Latitude:
Resisance: [ | cumi

in

= v
Low Temperature AC Resistance Altitude: ft

Stranding Factor: Line Azimuth:

I
High Temperature AC Resistance Output Selections

Resistance: : Q/mi
Layers: Type: Temperatures: |Std 100°C v
*Used in transient calculation only

*Used in transient calculation only
Core Diameter:

[ ]
Strand Diameter: :l
]

Time:

2
=

]

E

a
3
E
T A

g‘

Transient

Advanced
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1.4.4 Automated Updating

If a software or data update is available for SWRate Pro, you will be prompted to incorporate the updates if: (1) you
currently hold a maintenance contract and (2) the computer you are using is connected to the internet. The process for
installing software updates will be similar to the installation process. Data updates will be automatic.

1.5 Technical Support

For assistance, contact SWRate technical support at 1-877-797-2410, OHT@southwire.com, or visit us at
https://overheadtransmission.southwire.com/swrate-software-support/.

2 Main Menu Features

The Main Menu screen is divided into different sections, as shown below.

‘m

Type: ‘zmccmw:cms v ‘ Na l“a

- Tlé Denali/ZTACCR/TW/C7-TS

v| size: 195

Conductor Information

Material: (Al-Zr 60%

|

Strand Count: 20
strand Diameter: [
Stranding Factor:

Outer Diameter in

|

Compression: |None

Strand Lay: N/A| in

i

*Enter Strand Lay if single-layer ACSR

Core Information

Material: (C7

Strand Count:

|

Strand Diameter: 0.1365| in

Stranding Factor: ASTM

il

Core Diameter:

Trapwire Information

<

Layers: ‘3 Type: |16 v

These sections are:

I
Surface Construction

O Black @ Single

(O Non-Spec Duplex

O New Triplex

O Gray Quadruplex

@® Average Ins. Thickness
Thermal Coeffs - L
Absorptivity: Neutral Diameter

Emissivie: [ 03] . -

Spec Sheet Information

Strength: Std
REBS: 44500 Ib
Weight: 815| Ib/Mft

Local Conditions

Ambient: RG
Wind Speed: 20| fus
Wind Angle =

Sun: Vit
Solor Day
Local Time

*24:00 - Midnight, 12:00 - Noon

Condition Settings

Profiles Reset
Restore Save As
Default Default

Low Temperature AC Resistance

Temperature:

Resistance: 0.1209| Q/mi

*Used in transient calculation only

Location Conditions

Frequency: (60 | Hz
Atmosphere: |Clear v
Altitude: 0| ft
N. Latitude: s
Line Azimuth: ﬁ :

High Temperature AC Resistance

Temperature: 200{ °C
Resistance: 0.2031| Q/mi

*Used in transient calculation only

Output Selections

Resis. Units: [Q/ml v]

Loss of Strength

Temp I: ¢ Remaining
Time: hr
Steady-State Transient
Conductor Conductor
P L
Current Current
Rating Rating
Advanced
Calculate Batch
Ampacity Ampacity
Create Bundle
[«
p

Temperatures: |Std 200°C v

e Main Menu Toolbar: This toolbar contains the Main Menu tabs, which allow access to program Options,

Printer options, and Help.

e Conductor Selection: Type and Name inputs for selecting a conductor

e Primary Conductor Construction Information: Two (2) panels, one for information on the selected conductor’s

SWRate User’s Manual v1.0.
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outer conducting strands (Conductor Information) and one for information on the core (Core Information), if
applicable
e Additional Conductor/Cable Information: Seven (7) panels containing additional information used for

calculations, including some used strictly for the specification sheet
e Calculation Conditions: Two (2) panels are available for specifying the Local Conditions and Location Conditions.
An additional panel, the Condition Settings panel, allows saving and selection of calculation conditions.

e Calculation Options: Four (4) panels, one for Loss of Strength calculations, one for single Steady-State

calculations, one for single Transient calculations, and one for Advanced calculations (Pro version only). The
Steady-State and Transient panels contain two options, one to calculate a conductor temperature given a
current input, and the second to calculate a current rating given a conductor temperature input. The Advanced
panel (Pro version only) has button options for (1) creating a table of ampacities under given input conditions,
(2) outputting a collection of ampacity calculation sheets for multiple conductors, (3) outputting a spreadsheet
of steady-state and transient results for multiple conductors, including conductor properties, resistance, and
reactance, and (4) reactance calculations for various bundle/phase configurations.

2.1 Main Menu Toolbar Controls

2.1.1 File Menu

The File tab on the Main Menu provides access to two options:

e Options:
o Drop-down Sorting: The Name drop-down list can be sorted either alphabetically by code word (if

applicable) or by conductor size. Regardless of sorting method, the code word (if applicable), conductor
size, and stranding/type number will be shown.
o Sequence Impedance Info: Inputs used by the Sequence Impedance portion of the Calculate Ampacity

calculation routine (Pro version only)
e Printer: Activates the printer selection and setup dialog box
e Exit and Check-In License: Closes the program and checks the license seat in for use by another user (Pro

version only)

2.1.2 Help Menu

The Help tab on the Main Menu provides access to the following options:

e About: Displays the currently installed program version number, calculation method references, and contact
information for technical support: OHT@southwire.com or 1-877-797-2410
o Help: Contains instruction on how to activate context sensitive help for the input items on the Main Menu.
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When the cursor is placed into an input field either with the mouse or moved there using the Tab key, you can
access help for the value to be entered, if available, by pressing the F1 key.
e Revision History: Details improvements to the software (Pro version only)

e View Disclaimer: Displays the disclaimer for the software (Lite version only)

e User’s Manual: Opens this User’s Manual

2.1.3 Upgrade to Pro Menu (Lite Version Only)

This toolbar option allows you to license your SWRate software to run SWRate Pro. Contact OHT@southwire.com to
purchase an SWRate Pro license.

2.2 Conductor Selection

Conductor selection is done in two steps. First, select the type of conductor to be used (AAC, ACSR, etc.) from the Type
drop-down menu. The available types are discussed in the Appendix. Detailed information on each type of conductor
can be found in the Southwire Overhead Conductor Manual, which can be purchased at
https://southwireocm.p3medialink.com/product detail.php?id=71. Some conductor types are not available in the Lite

version.

After selecting a conductor type, the Name drop-down list will be populated with available conductor options. Select
the desired conductor in this drop-down. After a selection has been made, the Conductor Construction Information will
be automatically filled in.

2.3 Conductor Construction Information

There are two panels on the main input form that contain the primary Conductor Construction information for the
selected conductor. The first contains information on the outer conducting strands, and the second contains
information on the core, if applicable.

2.3.1 Conductor Information

For purposes of the calculations in this program, the conducting strands are assumed to be the primary electrical
conducting member of the construction. Conductor strands can be different types of aluminum, aluminum alloy, and
copper.
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Conductor Information

Material: |Al-Zr 60%

Strand Count: 20

Strand Diameter:

=

Stranding Factor: 1.0225

Outer Diameter: 1.01| in

Compression: (None v

Strand Lay: N/A| in

*Enter Strand Lay if single-layer ACSR

There are seven fields in this panel:

e Material: Material name for the outer conducting strands

e Strand Count: Number of outer conducting strands

e Strand Diameter: Diameter of each individual outer conducting strand, inches. Due to the irregular shape of
Trapezoidal-shaped Wire (TW) strands, the outer conducting strand diameter is not input for TW constructions.

e Stranding Factor: Length increment due to stranding

e Quter Diameter: Overall diameter of the conductor, inches

e Compression: Choose Compact for designs with compact (TW) strands. Choose Compressed for designs with
compressed outer strands. Compressed will be automatically selected for Al/Cu Duplex, Al/Cu Triplex, Al/Cu
Quadruplex, and AAC Line Wire. For TW and other compact aluminum conductors not already in the database,
each conductor layer diameter and number of strands per layer are required as inputs in the Layer Information
screen after selecting Compression => Compact in order for GMR and inductive reactance to calculate.

e Strand Lay (single-layer steel core conductors only): Length of lay of the outer strands

2.3.2 Core Information

For purposes of the calculations in this program, the core is defined as the mechanical support member of the
conductor. The core can be composed of coated steel wire, aluminum-clad steel wire (AW), C7® stranded carbon fiber
composite core, 3M° composite core, or aluminum alloy (when used as a core material in ACAR constructions).
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Core Information

Material: 1(7 4

Strand Count: ‘

~

Strand Diameter: 0.1365| in

Stranding Factor: 1.004

Core Diameter: 0,409@ in

There are five fields in this panel:

e Material: Material name for the core strands
e Strand Count: Number of core strands
e Strand Diameter: Diameter of each individual core strand, inches

e Stranding Factor: Length increment due to stranding

e Core Diameter: Overall diameter of the core, inches

2.3.3 Trapwire Information

When a TW construction (e.g. ACSS/TW) is selected, the number of Layers of aluminum strands and the Type number
(core to aluminum area ratio in percent) will be automatically populated.

Trapwire Information

Layers: Type: |16 v

2.3.4 Surface (Pro version only)

This selection will affect the thermal coefficients (Thermal Coeffs) and subsequent rating calculations. The Black and
Gray options are intended for covered conductors.

|
Surface

O Black

(O Non-Spec
(:) New

(O Gray

(®) Average

2.3.5 Thermal Coeffs

Although the surface condition of the conductor/cable can be selected in the Surface panel, Absorptivity and
Emissivity can also be custom defined in the Thermal Coeffs panel.
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Thermal Coeffs

Absorptivity: 05

1
Emissivity: 0.5

Emissivity is defined as the ratio of heat radiated to the surrounding air by the conductor to the heat radiated to the
surrounding air by a perfect “black body” radiator of the same dimensions.

Absorptivity is the ability of a conductor to absorb heat from its surroundings and is dependent upon conductor surface
conditions. Although solar heat absorption occurs at a different frequency range than heat radiation, both the
absorptivity and emissivity of an overhead conductor will increase over the life of the conductor, as a result of age and
atmospheric pollution.

Absorptivity and emissivity values of approximately 0.2 for new conductors and 0.9 for weathered bare overhead
conductors have been reported by House and Tuttle[3]. The exact rate of increase depends on the level of atmospheric
pollution and the line’s operating voltage. A value of 0.5 has been widely used when the actual conductor surface
condition is unknown. The values entered here are subject to engineering judgment.

Surface condition and corresponding absorptivity and emissivity values are shown below.

e Black: 0.95/0.91

e Non-Spec: 0.42/0.42
e New:0.23/0.23

e Gray: 0.5/0.5

e Average: 0.5/0.5

2.3.6 Construction (Pro Version Only)

For plexed covered conductors, the applicable construction, including Neutral Diameter, should be specified. For any
cable, Insulation Thickness should be entered.

I
Construction
@ Single

Duplex

Triplex

Quadruplex

Ins. Thickness
Neutral Diameter
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2.3.7 Spec Sheet Information

This panel contains conductor information that has no effect on the calculation results but will be printed on
calculation output files. Some conductor types, such as ACSS, allow selection of the applicable core strength; RBS
changes accordingly.

e
Spec Sheet Information

Strength: |Std

RBS: 44500| Ib
Weight: 815/ Ib/Mft

2.3.8 Low Temperature and High Temperature AC Resistance

Whereas steady-state calculations use calculated resistances, transient calculations use interpolated resistance. This is
because transient calculations require a complex, iterative process to calculate transient ratings. To ensure resistance
interpolation and improve calculation accuracy, Low and High Temperatures and Low and High Temperature AC
Resistances are recalculated for each transient calculation run based on calculation inputs. The Low and High
Temperature AC Resistance values on the Main Menu are provided for reference only.

Low Temperature AC Resistance

Temperature: 25| *C
Resistance: 0.1209| Q/mi

*Used in transient calculation only

High Temperature AC Resistance

Temperature: 200| °C

Resistance: 0.2031| Q/mi

*Used in transient calculation only

2.4 Calculation Conditions

There are two panels on the Main Menu that contain the specific calculation condition information. The Local
Conditions panel contains information on the local operating conditions, and the Location Conditions panel contains
assumptions related to the location of the line. For more information on these inputs, see your applicable conductor
ratings standard.
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2.4.1 Local Conditions

Local Conditions
Ambient: ’—4(2‘ LG
Wind Speed: ft/s
wind Angle: :
Sun: Auto| Wift?
Solar Day: 10 v
Local Time:
*24:00 - Midnight, 12:00 - Noon

e Ambient: Ambient air temperature, °C

¢ Wind Speed: Wind speed, feet per second (ft/s)

e Wind Angle: Angle between wind and axis of the conductor, degrees. A value of 90° indicates that the wind is
blowing perpendicular to the conductor, providing maximum convection cooling.

e Sun: Solar heat flux or intensity, W/ft? (Pro version only). “Auto” calculates this value using other calculation
conditions. SWRate Lite allows the “Auto” calculation, while SWRate Pro allows both input and “Auto”.

e Solar Day: Day of the year. The date chosen for the study impacts the position of the sun to the line, as does
Local Time.

e Local Time: Local sun time. The time of day affects the angle of the sun to the line, thus affecting the amount of
heat transferred. To calculate for a no-sun condition, input a value of 24:00. For noon, input 12:00.

2.4.2 Location Conditions

|
Location Conditions

Frequency: (60 v | Hz

Atmosphere: (Clear

I

Altitude:

N. Latitude:

Line Azimuth:

w
(=] =] ©
o o =2

e Frequency: Electrical frequency, Hz. Drop-down options are 50 Hz and 60 Hz.

e Atmosphere: Relates to local air pollution levels. The type of Atmosphere affects the amount of solar radiation.
The two available choices are Clear and Industrial.

e Altitude: Elevation of the line above sea level, feet
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e N. Latitude: North latitude of the line, degrees
e Line Azimuth: Direction of the line, degrees. Values are 0° or 180° (line running North-South) and 90° or 270°
(line running East-West).

2.5 Output Selections

Output Selections

Resis. Units: (Q/mi v

Temperatures: |Std 200°C

2.5.1 Resistance (Resis.) Units

A drop-down menu allows you to return calculation results in Q/Mft (Pro version only), Q/mi, or Q/km units. If Q/km is
selected, additional values such as conductor information and calculation conditions will be converted to Sl units when
results are printed or saved.

2.5.2 Temperatures

A drop-down menu allows you to select a preset temperature range, enter a range of Custom temperatures, or enter a
Range of evenly incremented temperatures. A preset temperature range is automatically selected based on the
selected conductor Type. However, you can choose a different preset temperature range or select Custom or Range.
Details on each are below.

e Std 75°C: default temperature range for copper conductor types; up to 75°C

e Std 90°C: temperature range up to 90°C

e Std 100°C: default temperature range for standard conductor types; up to 100°C

e Std 130°C: default temperature range for line wire and tree wire/spacer cable; up to 130°C

o Std 200°C: default temperature range for C7®-TS conductor types; up to 200°C

e Std 225°C: default temperature range for C7®-TP conductor types; up to 225°C

e Std 240°C: default temperature range for ACCR and MaxStorm™ conductor types; up to 240°C

e Std 250°C: default temperature range for ACSS with mischmetal or AW core; up to 250°C

e Custom: You can custom input up to 12 temperatures. The preset range is loaded by default into the table.
Entered values can be input in °C or °F units. Entered values must be greater than or equal to 25°C (77°F).
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Enter up to 12 temperatures (in °C) for which the ampacity
‘ is to be calculated.

Ampacity temperatures entered should be greater than
ambient (40°C) and less than 300°C.

Do not enter 20°C, the program automatically enters it.

Temperature 1: |25

Temperature 2: |50

|

Temperature 3:

Temperature 4:
Temperature 5:

Temperature 6: |125 O -

i
J

Values are:

Temperature 7: |150 @ c
Temperature 8: |175
Temperature 9: | 180

Temperature 10: | 200

Temperature 11:

Temperature 12:

LUEIEIEICIERE

|

e Range: You can define a Starting Temperature, Ending Temperature, and Increment. The software will then

define a temperature range based on your inputs. For Calculate Ampacity and Batch Ampacity calculations, the
temperature range should not be larger than 12. Entered values can be input in °C or °F units. Entered Starting

Temperature and Ending Temperature values must be greater than or equal to 25°C (77°F).

Enter a Starting Temperature, Ending Temperature, and Increment (in
¢C) at which the ampacity is to be calculated for.

Starting Temperature: |5

:

Values are: |
”“m |

Ending Temperature: [100 O-F

o L

Increment: |5

n
|
|
|
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2.6 Condition Settings (Pro version only)

Four (4) buttons allow saving and selection of calculation conditions.

Condition Settings

Profiles Reset
Restore Save As
Default Default

e Profiles: Save various calculation conditions
e Reset: Resets the calculation conditions to the default conditions
o Restore Default: Restores the factory default calculation conditions

e Save as Default: Saves the currently input calculation conditions as your default conditions

The default conditions provided with the SWRate software do not constitute a recommendation by Southwire as to the
appropriate conditions for your study, nor are they intended to replace engineering judgment, which you, the designer,
should exercise in determining conditions appropriate to your installation and operating conditions.

2.6.1 Profiles

Save various calculation conditions in tabular form to easily switch between rating assumptions. This is especially useful
for consultants that work with many clients. Absorptivity and emissivity can also be included in Profiles.

2.6.2 Reset

Resets the calculation conditions to the default conditions

2.6.3 Restore Default

Restores the factory default calculation conditions

2.6.4 Save as Default

Saves the currently input calculation conditions as your default conditions. If the calculation conditions used for your
studies are different from SWRate’s default conditions, you may want to enter your specific conditions and save these
as the defaults. Doing so will overwrite the defaults provided with SWRate software. These new defaults will then be
loaded whenever the program is run. If at any time you want to reset the default conditions to their factory values, you
can do so using the Restore Default button.
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2.7 Calculation Options

There are nine (9) calculation options available in SWRate software: one is for Loss of Strength calculations, two are for
Steady-State calculations, two are for Transient calculations, one is for calculating ampacity charts (Pro version only),
one is for batch ampacity charts (Pro version only), one is for batch spreadsheet calculations (Pro version only), and the
last is for Bundle Calculations (Pro version only).

Loss of Strength
Ti = o
=th Remaining
Stren,
Steady-State Transient
Conductor Conductor
Temperature Temperature
Current Current
Rating Rating
Advanced
Calculate Batch
Ampacity Ampacity
Create Bundle
Spreadsheet Calculation

Note that for single-layer steel core composite conductors, values above 75°C may be incorrect due to limited data for
modeling.

2.7.1 Loss of Strength

Given a conductor operating temperature (Temp) in °C and cumulative time duration (Time) in hours, the program will
calculate the Remaining Strength of the conductor in terms of the percent of the rated breaking strength (%RBS). This
option is only available for the following standard conductor types: AAC-based conductor types (including covered
conductors), AAAC-based conductor types (including covered conductors), ACAR, AACSR, and ACSR-based conductor
types (including covered conductors). High-temperature low-sag (HTLS) conductors (e.g. ACSS, C7® Overhead
Conductors, MaxStorm™ Overhead Conductors) have high normal operating temperatures and have very low risk of
strength loss.
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2.7.2 Steady-State Conductor Temperature

Selecting this option will calculate a steady-state conductor temperature based on an input current load. To run this
calculation, first select a conductor and input the desired operating parameters (Local Conditions and Location
Condlitions). Click the Conductor Temperature button in the Steady-State panel and the Steady-State Current Input

screen, shown below, will appear.

l

Steady-State Current: amperes

Enter a value for the Steady-State Current in amperes. Click Calculate and the Steady-State Temperature Rating results

screen, shown below, will be displayed.

Calculations are based on the information supplied for the
795.0 kemil Type 16 "Denali/ZTACCR/TW/C7-TS"
conductor and the specified conditions.

The given steady-state conductor current of 1000 amperes
results in the steady-state thermal rating below.

‘ Steady-State Temperature Rating: R
|

Rac @ 106.2°C: | 0.1586| Q/mi |

| Print | | Save |

This screen displays the calculated Steady-State Temperature Rating for the Steady-State Current provided, the solar
heat gain (Qs), the convection heat loss (Q¢), the radiated heat loss (Qr) and the ac resistance at the calculated

conductor temperature (Rac).

From this screen, you can Print the report or Save it to a .doc file. The report will contain the calculated data shown as

well as the conductor information and calculation conditions from the Main Menu.
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2.7.3 Steady-State Current Rating

Selecting this option will calculate a steady-state current rating based on an input conductor temperature. To run this
calculation, first select a conductor and input the desired operating parameters (Local Conditions and Location
Conditions). Click the Current Rating button in the Steady-State panel and the Steady-State Temperature Input screen,
shown below, will appear.

|

Enter the maximum allowable steady-state
temperature

Temperature: ~E
Calculate

Select the Temperature Units for the steady-state conductor temperature, and then enter a Temperature value. Click
Calculate and the Steady State Current Rating results screen will be displayed. The only difference will be that the
conductor current rating is displayed instead of a conductor temperature. The same output options are available.

2.7.4 Transient Conductor Temperature (Unavailable for Covered Conductors)

Selecting this option will calculate the maximum conductor temperature resulting from a temporary step increase in
current, assuming no change in weather conditions and the conductor is at thermal equilibrium prior to the step
increase in current. To run this calculation, first select a conductor and input the desired operating parameters (Local
Conditions and Location Conditions). Click the Conductor Temperature button in the Transient panel and the Transient
Data Input screen, shown below, will appear.

SWRate User’s Manual v1.0.0 Page 26 of 40



Transient calculations assume:

1 - The conductor is initially in thermal equilibrium.
2 - Astep increase in current occurs attime t=0.
3 - Weather conditions are constant before, during, and after the step increase.

Specify Metal Heat Capacities

Core:

Core Weight:

Outer Layers:

AL/CU Weight: | 0.7431| Ib/ft x

2| Ib/ft x Specific Heat:

Specific Heat:

413| W-s/Ib-*C = 29.8 W-s/ft-°C

412| W-s/lb-°C = 306.2 W-sift-°C

Specify an Initial Steady-State Condition

O Current: amperes

(® Temperature: 100| °C

Specify Calculation Time Interval

Conductor Temperature to be calculated every:

ransient Calculation Data

New Conductor Current, including step increase:

Total time duration for the transient:

E”V e (® minutes

L .

To perform a transient calculation, there are several inputs required:

o Metal Heat Capacities: This calculation is based on the material properties of the conductor. The program will
load default Weight and Specific Heat values for the materials found in the selected conductor type (both Core
and outer conducting (AL/CU) strands) and calculate the Metal Heat Capacity of the conductor. The values
provided are defaults used in the industry, and you should verify that these values are appropriate for the

conductor being used.
e Specify an Initial Steady State: An Initial Steady-State Temperature or Current must be specified. If a Current

load is entered, the program will use the steady-state algorithm to calculate the conductor temperature prior to
the application of the transient current load. Note that the Initial Steady-State Temperature should be (1)
greater than the ambient temperature and (2) greater than 25°C (77°F). If an Initial Steady-State Current is
specified and the resulting steady-state temperature is less than 25°C (77°F), the temperature will be elevated
to 25°C (77°F) for the transient calculation to maintain calculation accuracy.

e Specify Calculation Time Interval: A Time Interval for calculating the transient condition must be entered. This

will dictate how many calculations are run during the time the transient condition exists. This will also
determine the time axis values for the transient temperature Plot option.
e Transient Calculation Data: In this panel, the New Conductor Current, including step increase, and the Total
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time duration for the transient in minutes or seconds is entered.

Note that the same input screen is used for both the transient Conductor Temperature and Current Rating
calculations. The only difference occurs in the Transient Calculation Data panel. For a transient Conductor
Temperature calculation, the New Conductor Current is input, while the Max Conductor Temp. is input for a transient
Current Rating calculation.

Click the Calculate button to run the transient calculation. The Transient Calculation Results screen, shown below, will

be displayed.
= f
Calculations are based on the information supplied for the
795.0 kemil Type 16 "Denali/ZTACCR/TW/C7-TS" conductor and
the specified conditions. |
|
Initial Steady-State Conductor Temperature: 100.0| °C
Initial Steady-State Current: 950 amperes |
Calculation Time Interval: seconds
|
Transient Time Duration: 15| minutes !
Maximum Transient Conductor Temperature: 195.8| °C
Maximum Transient Current: 1650| amperes
| Print | | Save | | Plot | | Recalculate |

The Transient Calculations Results screen displays the Initial Steady-State Conductor Temperature and Current, the
conditions input for the transient, and in this case, the Maximum Transient Conductor Temperature resulting from the
input Maximum Transient Current for the indicated Transient Time Duration.

From this screen, you can Print the report or Save it to a .doc file. The report will contain the calculated data shown as
well as the Metal Heat Capacities and conductor information and calculation conditions from the Main Menu.
Additionally, the Recalculate button will return the program to the previous screen to allow changes in the transient
conditions. The Plot button will plot the temperature rise over time resulting from the transient step current, as shown
below.
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‘ 180

160
Conductor

Temperature,
I

{1 I I N Y N T T A T Y I |

‘ 100 T T T T T T T T T T T T T T T T T T T

‘ Time, minutes

Time Scale Increment: 0.75 minutes
‘ Temp. Scale Increment: 5°C m !
[

From this screen, a Print of the plot can be made.

Note that transient calculations use interpolated resistance. This is because transient calculations require a complex,
iterative process to calculate transient ratings. To ensure resistance interpolation and improve calculation accuracy,
Low and High Temperatures and Low and High Temperature AC Resistances are recalculated for each transient
calculation run based on calculation inputs.

2.7.5 Transient Current Rating (Unavailable for Covered Conductors)

Selecting this option will calculate the Maximum Transient Current based on a Maximum Transient Conductor
Temperature, assuming no change in weather conditions and the conductor is at thermal equilibrium prior to the step
increase in current. To run this calculation, first select a conductor and input the desired operating parameters (Local
Conditions and Location Conditions). Click the Current Rating button in the Transient panel and the Transient Data
Input screen will appear.

The only difference in this screen and the one provided for the transient conductor temperature option is a Max
Conductor Temp. must be entered into the Transient Calculation Data panel instead of a New Conductor Current. The
Max Conductor Temp. must be at least 10°C (18°F) higher than the ambient temperature. Also note that the Initial
Steady-State Temperature should be (1) greater than the ambient temperature and (2) greater than 25°C (77°F). If an
Initial Steady-State Current is specified and the resulting steady-state temperature is less than 25°C (77°F), the
temperature will be elevated to 25°C (77°F) for the transient calculation to maintain calculation accuracy.
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Click the Calculate button to run the transient calculation. The Transient Calculation Results screen will be displayed.
The only difference in this screen and the one from the transient conductor temperature calculation is that the Plot
option is unavailable.

Note that transient calculations use interpolated resistance. This is because transient calculations require a complex,
iterative process to calculate transient ratings. To ensure resistance interpolation and improve calculation accuracy,
Low and High Temperatures and Low and High Temperature AC Resistances are recalculated for each transient
calculation run based on calculation inputs.

2.7.6 Calculate Ampacity (Pro version only)

This calculation creates tabulated ampacity results using the Temperatures defined in the Output Selections panel. To
run this calculation, first select a conductor and input the desired operating parameters (Local Conditions and Location
Conditions). Confirm your Temperatures in the Output Selections panel or make changes as desired. Click the Calculate
Ampacity button in the Advanced panel and the Results screen will appear. For single-layer steel core conductors, a
Calculating Single-Layer Values screen will appear prior to the Results screen to track the progress of this complex
calculation.

The Results screen includes operating temperatures in °C and °F (reflective of 20°C (68°F) and the defined
Temperatures), DC and AC Resistance, ampacity under various Sun and Wind conditions, conductor GMR, and
Inductive (Xa/Xl) & Capacitive Reactance (X’a/Xc) at 1-ft spacing (spacing is non-applicable for plexed covered
conductors).
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-

Print View Sequence 0 Includg Sequgn:e Impedance CMB 0.9348 ft ,
| Impedance Data Data with Printout Xa @ 1ft: 0.4075 QU/mi ‘
X'a @ 1ft: 0.0940 MQ-mi
Save ‘
*C 2 DC Resistance  AC Resistance Sun - No Wind No Sun - No Wind Sun - Wind No Sun - Wind
20.0 68.0 0.1173
25.0 77.0 0.1197 0.1209 el ik i Wik
50.0 122.0 0.1314 0.1325 ededk 298 186 441
75.0 167.0 0.1431 0.1441 461 599 702 800 ‘
90.0 194.0 0.1502 0.1511 622 726 862 940 ]
! 1000 2120 0.1548 0.1558 710 800 950 1019
I 1150 2390 0.1619 0.1628 823 898 1064 1123
1200 2480 0.1642 0.1651 857 929 1098 1155
1250 257.0 0.1666 0.1674 890 958 1131 1185
150.0 3020 0.1783 0.1791 1037 1092 1277 1322
1750 3470 0.1900 0.1908 1164 121 1401 1440 ‘
180.0 356.0 0.1924 0.1931 1188 1233 1425 1462
200.0 3920 0.2017 0.2024 1278 1318 1512 1546 |

Available buttons and options on the Results screen:

e  Print: Print the report. The report will contain the tabulated data shown as well as the conductor information
and calculation conditions from the Main Menu.

e Save: Save the report to a .doc file. The report will contain the tabulated data shown as well as the conductor
information and calculation conditions from the Main Menu.

e View Sequence Impedance Data: View the Sequence Impedance Results screen (see below). The screen

includes operating temperatures in °C and °F (reflective of 20°C (68°F) and the defined Temperatures), DC
Resistance, R (positive sequence ac resistance), Xl (positive sequence inductive reactance), Xc (positive
sequence capacitive reactance), RO (zero sequence ac resistance), XI0 (zero sequence inductive reactance), Xc0
(zero sequence capacitive reactance), GMD (as defined in File => Options => Sequence Impedance Inputs), Line
Height (as defined in File => Options => Sequence Impedance Inputs), conductor GMR, and Inductive (Xa/Xl) &
Capacitive Reactance (X’a/Xc) at 1-ft spacing (spacing is non-applicable for plexed covered conductors).

¢ Include Sequence Impedance Data with Printout: A separate printout that includes sequence impedance data

will be printed prior to the ampacity results.
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GMR: 0.0348 ft
‘ Xa @ 1ft: 0.4075 Q/mi
X'a @ 1ft: 0.0940 MQ-mi
Line GMD: 31.5ft
Line Height: 50 ft
Earth Resistivity: 100 Q-m |

“C °F DC Resistance R Xl Xc RO X0 Xc0

200 68.0 0.1173
25.0 77.0 0.1197 0.1209 0.8262 0.1963 0.4067 24582 0.2993
50.0 1220 0.1314 0.1325 0.8262 0.1963 0.4183 2.4582 0.2993
‘ 75.0 167.0 0.143 0.1447 0.8262 0.1963 0.4299 24582 0.2993 I
90.0 194.0 0.1502 0.151 0.8262 0.1963 0.4369 24582 0.2993
| | 1000 2120 0.1548 0.1558 0.8262 0.1963 0.4416 24582 0.2993
1150 239.0 0.1619 0.1628 0.8262 0.1963 0.4486 2.4582 0.2993
1200 2480 0.1642 0.1651 0.8262 0.1963 0.4509 24582 0.2993
1250 2570 0.1666 0.1674 0.8262 0.1963 0.4532 24582 0.2993
150.0 3020 0.1783 0.1791 0.8262 0.1963 0.4649 24582 0.2993
1750 3470 0.1900 0.1908 0.8262 0.1963 0.4766 24582 0.2993
180.0 356.0 0.1924 0.1931 0.8262 0.1963 0.4789 2.4582 0.2993
2000 3920 0.2017 0.2024 0.8262 0.1963 0.4882 24582 0.2993 |

Note that for single-layer and three-layer steel core composite conductors, ac resistance is calculated at the highest
current shown for each temperature. For single-layer steel core composite conductors, inductive reactance is
calculated at the highest current at 75°C.

2.7.7 Batch Ampacity (Pro version only)

This calculation outputs a collection of tabulated ampacity calculation sheets using the Temperatures defined in Output
Selections. To run this calculation, first select a conductor Type and input the desired operating parameters (Local
Conditions and Location Conditions). Confirm your Temperatures in the Output Selections panel or make changes as
desired. Click the Batch Ampacity button in the Advanced panel and the Multiple Conductor Selection screen will
appear.
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| [ select Al
| [J203.2 - T43 Fundy/ZTACCR/TW/C7-TS A | Accept I |
| 2] 266.8 - T21 Shenandoah/ZTACCR/TW/C7-TS |
:‘ 325 - T17 Olympic/ZTACCR/TW/C7-TS
:‘ 336.4 - T17 Wrangell/ZTACCR/TW/C7-TS
:‘ 336.4 - T22 Badlands/ZTACCR/TW/C7-TS
[]3s7.5 - T14 Andes/ZTACCR/TW/C7-TS
[]3s7.5 - T16 Joshua Tree/ZTACCR/TW/C7-TS
:‘ 357.5 - T22 Sequoia/ZTACCR/TW/C7-TS
:‘ 477 - Ti3 Rogers/ZTACCR/TW/C7-TS
:‘ 477 - T1s Yosemite/ZTACCR/TW/C7-TS
2 477 - T23 Capitol Reef/ZTACCR/TIW/C7-TS
[] e36 - T10 Tortugas/ZTACCR/TW/C7-TS
(] e36 - Ti12 Yellowstone/ZTACCR/TW/C7-TS
:‘ €3¢ - T1s Glacier/ZTACCR/TW/C7-TS
:‘ 636 - T22 Carlsbad/ZTACCR/TW/C7-TS
:‘ €41.7 - Tl11 Congaree/ZTACCR/TW/C7-TS
j 714 - Ti0 Vinson/ZTACCR/TW/C7-TS
D 795 =017 Kilimanjaro/ZTACCR/TW/C7-TS
BEES = f) 2Alps/ZTACCR/TIW/C7-TS
:‘ 755 - T12 Wind Cave/ZTACCR/TW/C7-TS
%755 - Tic  Denali/ZTACCR/TW/CT-TS | ,
:‘ 785 - T22 Rocky/ZTACCR/TW/C7-TS
| :] 954 — Crater Lake/ZTACCR/TW/C7-TS
[] os4 - T10 Grand Canyon/ZTACCR/TW/C7-TS
2] 954 - T12 Fuji/ZTACCR/TW/C7-TS
:‘ 954 - T16 Jasper/ZTACCR/TW/C7-TS
:‘ 954 - T20 Arches/ZTACCR/TW/C7-TS
:‘ 973.1 - T14 Everglades/ZTACCR/TW/C7-TS
[]1033.5 - Ts Big Bend/ZTACCR/TW/C7-TS
[J1033.5 - 17 Lassen/ZTACCR/TW/C7-TS
:] 1033.5 - T11 Tahoe/ZTACCR/TW/C7-TS
:‘ 1033.5 - T13 Samoa/ZTACCR/TW/C7-TS
:‘ 1113 - TS Cook/ZTACCR/TW/C7-TS
:| 1113 — Blanc/ZTACCR/TW/C7-TS
[J1113 - T10 Niagara/ZTACCR/TW/C7-TS
[J1113 - T13 Gannett/ZTACCR/TW/C7-TS
:‘ 1152.5 - TS Washington/ZTACCR/TW/C7-TS I
:‘ 1182.5 - 17 Elbert/ZTACCR/TW/C7-TS
I'|{01192.5 - T10 Kings Canyon/ZTACCR/TW/C7-TS
j 1192.5 - T13 Acadia/ZTACCR/TW/C7-TS N

This screen displays the conductor options and allows you to select multiple conductors. Also note the Select All option
at the top of the screen. Keep in mind that these calculations could take some time. Once you have made your
selections, click Accept. A Print screen will appear to confirm your printer selection before proceeding with the
calculations and printing.

For single-layer steel core conductors, a Calculating Single-Layer Values screen will appear prior to the Results screen
to track the progress of this complex calculation. Each printed report will contain the tabulated data as described in the
Calculate Ampacity, Section 2.7.6.

Note that for single-layer and three-layer steel core composite conductors, ac resistance is calculated at the highest
current shown for each temperature. For single-layer steel core composite conductors, inductive reactance is
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calculated at the highest current at 75°C.

2.7.8 Create Spreadsheet (Pro version only)

The Create Spreadsheet calculation produces a spreadsheet of steady-state and transient results for multiple
conductors, including conductor properties, resistance, and reactance. To run this calculation, first select a conductor
Type and input the desired operating parameters (Local Conditions and Location Conditions). Click the Create
Spreadsheet button in the Advanced panel and the Multiple Conductor Selection screen will appear as shown below.
This screen displays the conductor options and allows you to select multiple conductors. Also note the Select All option
at the top of the screen. Keep in mind that these calculations could take some time, especially if transient calculations
are also chosen. Once you have made your selections, click Accept. A Request Confirmation screen will appear to
confirm you want to proceed with the calculations. Upon clicking Yes, the program will ask if you want to calculate
transient ratings as well (unavailable for covered conductors). If you click Yes, the Transient Ampacity Input screen will
appear as shown below.

Transient calculations assume:

1 - The conductor is initially in thermal equilibrium.
2 - A step increase in current occurs attime t=0.
3 - Weather conditions are constant before, during, and after the step increase.

Specify Metal Heat Capacities

Core:

Core Weight: 0.0722 Ib/ft x Specific Heat: 413| W-s/lb-*C = 29.8 W-sift-*C

Outer Layers:
AL/CU Weight: | 0.7431 Ib/ft x Specific Heat: 412| W-s/lb-*C = 306.2 W-s/ft-°C

Transient Calculation Data
Starting Current, Percent of Steady-State Current at Tc

100| % (@ AsDefined in Output Selections O Input: =<

Max Conductor Temp. during the transient:

(O As Defined in Output Selections @ Input: 200| °C
Total time duration for the transient: Conductor Temperature to be calculated every:
15 @ minutes () seconds 60| seconds

To calculate transient ratings within Create Spreadsheet, several inputs are required:

o Metal Specific Heats: Unlike the single transient calculation, Weights are not editable since the Create
Spreadsheet calculation handles multiple conductors, all with different Weights. Transient rating calculations
are based on the material properties of the conductor. The program will load default Specific Heat values for
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the materials found in the selected conductor type (both Core and outer conducting (AL/CU) strands). The
values provided are defaults used in the industry, and you should verify that these values are appropriate for
the conductor being used.

e Transient Calculation Data:

o Aninitial steady-state Starting Current must be specified as a Percent of the calculated Steady-State
Current at Tc. You must specify a Percent (default is 100%) and temperature. You may specify
temperature As Defined in Output Selections (your temperature range) or by a single Input
temperature.

o A Max Conductor Temp. during the transient must be specified As Defined in Output Selections (your
temperature range) or by a single Input temperature. If the As Defined in Output Selections
radiobutton is selected, a Percent lower than 100% must be specified in the Starting Current section.
The Max Conductor Temp. must be at least 10°C (18°F) higher than the ambient temperature. Also note
that the initial steady-state temperature should be (1) greater than the ambient temperature and (2)
greater than 25°C (77°F). If an initial steady-state current yields a steady-state temperature less than
25°C (77°F), the temperature will be elevated to 25°C (77°F) for the transient calculation to maintain
calculation accuracy.

Total time duration for the transient in minutes or seconds must be entered (15 minutes is default)
Conductor Temperature to be calculated every — A time interval for calculating the transient condition
must be entered. This will dictate how many calculations are run during the time the transient condition
exists.

Click the Calculate button to proceed with Create Spreadsheet calculations. The Input File Path and Name screen,
shown below, will be displayed.

Click Browse to select a destination for your output .xlsx file. Also edit the Filename as needed. Click Accept when
ready to initiate the calculations. For single-layer steel core conductors, a Calculating Single-Layer Values screen will
appear to track the progress of this complex calculation. The Building Excel File screen will also appear to track the
progress of the overall calculation. Once the calculation finishes, these screens will disappear, and the .xlIsx file will be
saved to the specified destination on your computer.

Note that transient calculations use interpolated resistance. This is because transient calculations require a complex,
iterative process to calculate transient ratings. To ensure resistance interpolation and improve calculation accuracy,
Low and High Temperatures and Low and High Temperature AC Resistances are recalculated for each transient
calculation run based on calculation inputs.

Note that for single-layer and three-layer steel core composite conductors, ac resistance is calculated at the highest
current shown for each temperature. For single-layer steel core composite conductors, inductive reactance is
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calculated at the highest current at 75°C.

2.7.9 Bundled Calculation (Pro version only)

Calculate the inductive and capacitive reactances for a provided bundle and phase configuration. To run this
calculation, first select a conductor and input the desired operating parameters (Local Conditions and Location
Conditions). Click the Bundle Calculation button in the Advanced panel and the Bundle Calculation Information screen
will appear.

Select the Bundle and Phase configurations.

Bundle C " Conductor GMR: 0.0342 ft
Q_’ ¢. .‘_ ,# Custom Conductors
A A B per Bundle:
Distance A: 0 ft
O O O
Distance B: 0 ft
Ai EA A& Ai‘ :B Distance C: 0 ft
|
‘ A A C Bundle GMD: 0 ft
O O O
Phase Configuration Distance A: 0 ft
Distance B: 0 ft
+~ ¢ ¢‘ "' '# Custom Phase GMD: 0 fe
A A B
- © ©

Choose from various Bundle Configurations and Phase Configurations. When a radiobutton is selected, the Bundle
Info screen will appear so that you can enter the applicable distances between conductors.
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3 Conductors, Flat ;

Dimension A: ft
Dimension B: ft
Dimension C: E ft

Click the Calculate button to run the bundle calculation. The Bundle Calculation Results screen, shown below, will be

)

displayed. From this screen, you can Print the report. The report will contain the calculated data shown as well as the
conductor information and calculation conditions from the Main Menu. Only calculation conditions that affect the
calculation result will be shown in the printout.

.|
Inductive Capacitive
Reactance Reactance
(Q/mi) (MQ-mi)

Conductor at GMD =1 ft: | 0.4075 0.0940
| Bundle at GMD =1 ft: | 0.1030

Bundle at GMD =189 ft: [ 0.4597 0.1105

e
=}
o
W
w
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Appendix
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Abbreviations
Conductor Types
AAC

AAC/TW

AAAC

ACAR

AACSR

ACSR

ACSR/TW
ACSR/AW

ACSS

ACSS/TW
ACSS/AW
ACSS/TW/AW
MaxStorm™

ACCS/TW/C7°-TS
ZTACCR/TW/C7°-TS

ACCS/TW/C7°®-TP
ZTACCR/TW/C7°-TP

ACCR
ACCR/TW
AAC/VR2®
ACSR/VR2®
Al

Cu

Duplex
Triplex
Quadruplex
HD Copper
MHD Copper
SD Copper
Line Wire
Tree Wire

All-Aluminum Conductor

Shaped Wire Compact All-Aluminum Conductor

All-Aluminum Alloy Conductor (6201-T81 Alloy)

Aluminum Conductor, Aluminum Alloy Reinforced (1350/6201 Alloy)

Aluminum Alloy Conductor, Steel Reinforced (6201-T81 Alloy)

Aluminum Conductor, Steel Reinforced

Shaped Wire Compact Aluminum Conductor, Steel Reinforced

Aluminum Conductor, Aluminum-Clad Steel Reinforced

Aluminum Conductor, Steel Supported

Shaped Wire Compact Aluminum Conductor, Steel Supported

Aluminum Conductor, Aluminum-Clad Steel Supported

Shaped Wire Compact Aluminum Conductor, Aluminum-Clad Steel Supported
Shaped Wire Compact Thermal-Resistant Aluminum Conductor, UHS Steel Reinforced
(ZTACSR/TW/MADB)

Shaped Wire Compact Aluminum Conductor, Thermoset Composite Supported
Shaped Wire Compact Thermal-Resistant Aluminum Conductor, Thermoset Composite
Reinforced

Shaped Wire Compact Aluminum Conductor, Thermoplastic Composite Supported
Shaped Wire Compact Thermal-Resistant Aluminum Conductor, Thermoplastic Composite
Reinforced

Thermal-Resistant Aluminum Conductor, Composite Reinforced

Shaped Wire Compact Thermal-Resistant Aluminum Conductor, Composite Reinforced
Vibration-Resistant, Twisted Pair All-Aluminum Conductor

Vibration-Resistant, Twisted Pair Aluminum Conductor, Steel Reinforced

Aluminum

Copper

Covered conductor plexed with a bare neutral

Two covered conductors and a bare neutral, all plexed together

Three covered conductors and a bare neutral, all plexed together

Hard-Drawn Copper

Medium-Hard-Drawn Copper

Soft-Drawn Copper

Single Covered Conductor

Single Covered Conductor designed for momentary contact with trees
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Spacer Cable Single Covered Conductor designed for spacer cable systems

Other

GA# Galvanized Zinc Steel Core Coating (# equals strength rating)
GMD Geometric Mean Distance, between conductors

GMR Geometric Mean Radius, used in inductive reactance calculations
HS285°® Southwire proprietary Ultra-High Strength Steel Core

MA# Mischmetal Steel Core Coating (# equals strength rating)

TW Trapezoidal-Shaped Wire
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